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[bookmark: _Toc484789136][bookmark: _Toc41288795]Testování vykazování webovými službami SDAT
[bookmark: _Toc41288796]Účel dokumentu
Dokument popisuje strategii testování, testovací scénáře a testovací data. Tento dokument bude průběžně doplňován o další scénáře. 
Pro úvodní test zaslání vstupní zprávy byl vybrán výkaz CEUSIFE10 vykazovacího rámce CEU.
Obecně platí, že na úvod je vždy popsán a doporučen k testování hlavní úspěšný scénář.
[bookmark: _Toc412753853][bookmark: _Toc515204362][bookmark: _Toc41288797]Odkazy na dokumentaci SDAT
Informace potřebné k provedení testů jsou dostupné v dokumentech technické specifikace systému SDAT kterou tvoří sada níže uvedených dokumentů. 
Konkrétně se jedná o dokumenty SDAT_TS_3_Vykazovani a SDAT_TS_6_KatalogWebovychSluzeb.

	
	Název
	Popis 

	0
	Základní dokument
	Popisuje strukturu dokumentace SDAT.

	1
	Popis systému
	Popisuje základní vlastnosti a architekturu se zaměřením na funkce určené pro externí uživatele.

	2
	Metapopis vykazovací povinnosti
	Popisuje způsoby, kterými lze získat informace o metodikách vykazování a o vykazovací povinnosti – jak webovými službami, tak přes uživatelské rozhraní webové aplikace.

	3
	Vykazování
	Popisuje způsoby, kterými lze zaslat Vydání výskytů výkazů podle předepsané vykazovací povinnosti a možnosti získání informací o stavu jejich zpracování.

	4
	Vykazování – specifické případy
	Rozcestník na samostatné dokumenty popisující specifické případy či způsoby vykazování (AnaCredit, ISO20022 a další).

	5
	Technické informace
	Popisuje technické náležitosti jednotlivých komunikačních rozhraní.

	6
	Katalog webových služeb
	Popisuje webové služby – primární rozhraní pro automatizované vykazování (tento dokument).

	7
	Modely metapopisu
	Popisuje architekturu systému na úrovni vybraných entitních modelů.

	8
	Popis jazyka kontrol
	Popisuje jazyk kontrol systému SDAT.




[bookmark: _Ref18436949][bookmark: _Toc41288798]Předpoklady a doporučení pro testování
[bookmark: _Toc41288799]Aktivace přístupu do neveřejné části portálu SDAT
Pro přístup do neveřejné části portálu SDAT je možné požádat na adrese sdat@cnb.cz. Zřízen bude jeden administrátorský účet, jehož prostřednictvím lze spravovat další uživatelské účty v kontextu příslušné vykazující osoby. 
[bookmark: _Toc41288800]Registrace SSL certifikátu
Autentizace webových služeb vyžaduje komerční certifikát pro šifrování komunikace. ČNB akceptuje certifikáty vydané kvalifikovaným poskytovatelem služeb vytvářejících důvěru ve smyslu článku 3 bodu 20 Nařízení eIDAS, který je uveden na důvěryhodném seznamu Ministerstva vnitra dle § 13 odst. 3 Zákona o službách vytvářejících důvěru pro elektronické transakce. Certifikát je možné nahrát prostřednictvím webové aplikace SDAT v části Správa osoby -> Certifikáty. Distribuce na webové servery probíhá jednou denně, do 24 hodin nejdéle by měl být přístup funkční.
[image: ]
[bookmark: _Toc41288801]Nástroj  SoapUI
Pro testování webových služeb je možné použít volně dostupný nástroj SoapUI (https://www.soapui.org/), který uživatelskou formou poskytne potřebnou funkcionalitu. 
Založení projektu
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Přidání certifikátu (privátní klíč odpovídající certifikátu pro autentizaci webových služeb zaregistrovaném v SDAT)
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Nastavení SSL Keystore pro příslušný request
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Ověření správného nastavení konfigurace zasláním requestu
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[bookmark: _Toc41288802]Seznam testovacích scénářů
	
	Název
	Popis 

	TEST_0.1
	Ověření komunikace
	Ověření komunikace zavolání služby CtiUdajeOsoby

	TEST_1.1
	Zaslání nechybového výkazu CEUSIFE10
	Pro úvodní test zaslání vstupní zprávy byl vybrán výkaz CEUSIFE10 vykazovacího rámce CEU.

	TEST_1.2
	Zaslání podepsaného výkazu CEUSIFE10
	Zaslání vstupní zprávy s elektronickým podpisem. 

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	




[bookmark: _Toc41288803]Testovací scénáře a testovací data
[bookmark: _Toc41288804]Scénář TEST_0.1 ověření konektivity 
Cílem testu je:
· po registraci komerčního certifikátu pro SSL komunikaci do systému  SDAT (viz kapitola Předpoklady a doporučení pro testování) ověřit konektivitu SSL komunikace zavoláním nejjednodušší webové služby CtiUdajeOsoby bez parametrů
Krok 1 – zavolání služby CtiUdajeOsoby
Po registraci SSL certifikátu ověřte komunikaci zasláním požadavku na službu CtiUdajeOsoby
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:urn="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:CtiUdajeOsobyRequest>
         <ZadostInfo>
            <CasZadosti>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</CasZadosti>
            <ZadostId>${=UUID.randomUUID()}</ZadostId>
            <VerzeZadosti>1.0.0</VerzeZadosti>
            <OsobaKod>9999</OsobaKod>
         </ZadostInfo>
         <Dotaz>
         </Dotaz>
      </urn:CtiUdajeOsobyRequest>
   </soapenv:Body>
</soapenv:Envelope>
Kde hodnotu OsobaKod nahraďte kódem osoby s registrovaným certifikátem a výrazy v CasZadosti a ZadostId aktuálním časem odeslání žádosti resp. Identifikátorem žádosti. 
V případě úspěšného volání vrátí služba obdobu následujícího response:
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
   <SOAP-ENV:Header>
      <!--generated on AKC 2019-09-03T20:55:57.074 by 0.58.0-2019-09-02T12:14:19Z-->
   </SOAP-ENV:Header>
   <SOAP-ENV:Body>
      <cuo:CtiUdajeOsobyResponse xsi:schemaLocation="urn:cz:cnb:sdat:schemas:CtiVykaz:v1 xsd/informacni_sluzby/CtiVykaz.xsd
urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1 xsd/informacni_sluzby/CtiSeznamVykazu.xsd
urn:cz:cnb:sdat:schemas:CtiSeznamMetodik:v1 xsd/informacni_sluzby/CtiSeznamMetodik.xsd
urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1 xsd/informacni_sluzby/CtiVykazovaciPovinnost.xsd
urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1 xsd/informacni_sluzby/CtiUdajeOsoby.xsd
urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1 xsd/informacni_sluzby/CtiStavVykazovani.xsd
urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1 xsd/informacni_sluzby/CtiStavZpracovani.xsd
urn:cz:cnb:sdat:schemas:CtiTypyOsob:v1 xsd/informacni_sluzby/CtiTypyOsob.xsd
urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1 xsd/vykazovaci_sluzby/ZaslaniVstupniZpravy.xsd
urn:cz:cnb:sdat:schemas:DatoveTypy:v1 xsd/common/DatoveTypy.xsd
urn:cz:cnb:sdat:schemas:ObjektyTypy:v1 xsd/common/ObjektyTypy.xsd
urn:cz:cnb:sdat:schemas:SystemTypy:v1 xsd/common/SystemTypy.xsd
urn:cz:cnb:sdat:schemas:SpecialniTypy:v1 xsd/common/SpecialniTypy.xsd
urn:cz:cnb:sdat:schemas:SpolecneTypy:v1 xsd/common/SpolecneTypy.xsd" xmlns:csm="urn:cz:cnb:sdat:schemas:CtiSeznamMetodik:v1" xmlns:csv="urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1" xmlns:csvy="urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1" xmlns:csz="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1" xmlns:cto="urn:cz:cnb:sdat:schemas:CtiTypyOsob:v1" xmlns:cuo="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1" xmlns:cvp="urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1" xmlns:cvy="urn:cz:cnb:sdat:schemas:CtiVykaz:v1" xmlns:czv="urn:cz:cnb:sdat:schemas:CtiZmenyVykazu:v1" xmlns:ds="http://www.w3.org/2000/09/xmldsig#" xmlns:obj="urn:cz:cnb:sdat:schemas:ObjektyTypy:v1" xmlns:prot="urn:cz:cnb:sdat:schemas:Protokoly:v1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:zvz="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1">
         <OdpovedInfo>
            <CasOdpovedi>2019-09-03T20:55:57.052</CasOdpovedi>
            <ZadostId>30dcd771-1e2a-4170-87e7-84a7bb4813b9</ZadostId>
            <VerzeSluzby>1.0.0</VerzeSluzby>
            <Status>
               <VysledekKod>OK</VysledekKod>
            </Status>
         </OdpovedInfo>
         <Odpoved>
            <Osoba>
               <Kod>9999</Kod>
<!-- kráceno -->


Možné chyby:
1)
Error getting response; javax.net.ssl.SSLHandshakeException: Received fatal alert: handshake_failure
- nepodařilo se navázat SSL komunikaci, request není zaslán s příslušným certifikátem.
2)
<VysledekKod>CHYBA</VysledekKod>
<VysledekDetail>
<VysledekSubKod>NENI_OPRAVNENI</VysledekSubKod>
<VysledekPopis>Certificate mismatch: osoba=9998, sn=25514C, issuer=serialNumber=NTRCZ-26439395,O=PrvnÃ¬ certifikaÄ�nÃ¬ autorita\, a.s.,CN=I.CA Public CA/RSA 07/2015,C=CZ</VysledekPopis>
</VysledekDetail>
Request je odeslán správně, ale certifikát není zaveden na straně SDAT.
[bookmark: _Toc41288805]TEST_1 – Vykazovací rámec CEU
[bookmark: _Toc41288806]Scénář TEST_1.1 zaslání nechybového výkazu CEUSIFE10
Cílem testu je: 
· Odeslat validní Vstupní zprávu obsahující jedno Vydání výskytu výkazu za výkaz CEUSIFE10 ve verzi metodiky CEU20190101.1. 
· Přečíst informace o úspěšném zaslání.
· Přečíst informace o stavu zpracování v ČNB včetně protokolů.
Krok 1 – příprava Vydání výskytu výkazu ve formátu SDAT-XML
V tomto kroku je třeba vytvořit validní datový obsah, který odpovídá definici komplexního datového typu DataVstupniZpravyType (ZaslaniVstupniZpravy.xsd). Nejjednodušší způsob jak XML soubor odpovídající získat je export z webové aplikace SDAT, viz postup v kapitole Příprava testovacích dat ve webové aplikaci. 
Příklad Vydání výskytu výkazu:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<zvz:DataVstupniZpravy xmlns:ds="http://www.w3.org/2000/09/xmldsig#" xmlns:csz="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1" xmlns:czv="urn:cz:cnb:sdat:schemas:CtiZmenyVykazu:v1" xmlns:cvp="urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1" xmlns:obj="urn:cz:cnb:sdat:schemas:ObjektyTypy:v1" xmlns:cvy="urn:cz:cnb:sdat:schemas:CtiVykaz:v1" xmlns:cuo="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1" xmlns:zvz="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1" xmlns:ns10="urn:cz:cnb:sdat:schemas:Protokoly:v1" xmlns:csvy="urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1" xmlns:csv="urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:schemaLocation="urn:cz:cnb:sdat:schemas:CtiVykaz:v1 xsd/informacni_sluzby/CtiVykaz.xsd&#xA;urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1 xsd/informacni_sluzby/CtiSeznamVykazu.xsd&#xA;urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1 xsd/informacni_sluzby/CtiVykazovaciPovinnost.xsd&#xA;urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1 xsd/informacni_sluzby/CtiUdajeOsoby.xsd&#xA;urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1 xsd/informacni_sluzby/CtiStavVykazovani.xsd&#xA;urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1 xsd/informacni_sluzby/CtiStavZpracovani.xsd&#xA;urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1 xsd/vykazovaci_sluzby/ZaslaniVstupniZpravy.xsd&#xA;urn:cz:cnb:sdat:schemas:DatoveTypy:v1 xsd/common/DatoveTypy.xsd&#xA;urn:cz:cnb:sdat:schemas:ObjektyTypy:v1 xsd/common/ObjektyTypy.xsd&#xA;urn:cz:cnb:sdat:schemas:SystemTypy:v1 xsd/common/SystemTypy.xsd&#xA;urn:cz:cnb:sdat:schemas:SpecialniTypy:v1 xsd/common/SpecialniTypy.xsd&#xA;urn:cz:cnb:sdat:schemas:SpolecneTypy:v1 xsd/common/SpolecneTypy.xsd">
	<Vydani>
		<HlavickaVydani>
			<VykazKod>CEUSIFE10</VykazKod>
			<OsobaKod>9999</OsobaKod>
			<StavKeDni>2019-06-28</StavKeDni>
			<RozsahKod>S_BCPZB</RozsahKod>
			<MetodikaKod>CEU20190101.1</MetodikaKod>
			<Format>XMLSDAT</Format>
			<CisloVydani>1</CisloVydani>
			<TypVydani>DATA</TypVydani>
		</HlavickaVydani>
		<DataVydani>
			<DataFormatSdatXml>
				<DatoveOblasti>
					<DataDo Kod="CEU10_11">
						<Ra Kod="1" Poradi="1">
							<Sl Kod="1">1</Sl>
							<Sl Kod="2">18.06.2019 09:15:40</Sl>
							<Sl Kod="3">ZA</Sl>
							<Sl Kod="4">000001</Sl>
							<Sl Kod="5">1000000001</Sl>
							<Sl Kod="6">10</Sl>
							<Sl Kod="7">D</Sl>
							<Sl Kod="8">440</Sl>
							<Sl Kod="9">Nfjeweishv</Sl>
							<Sl Kod="10">Bhtlyytvwm</Sl>
							<Sl Kod="11">8102164587</Sl>
							<Sl Kod="12">16.02.1981</Sl>
							<Sl Kod="13">8102164587</Sl>
							<Sl Kod="14">IID</Sl>
							<Sl Kod="15">Pxzpxxztkr</Sl>
							<Sl Kod="16">Vpbwzgxwlf</Sl>
							<Sl Kod="17">IID</Sl>
							<Sl Kod="18">Vmwfmuvetm</Sl>
							<Sl Kod="19">Dnypfguevb</Sl>
							<Sl Kod="20">Tplwsisoih</Sl>
							<Sl Kod="21">8102164587</Sl>
							<Sl Kod="22">16.02.1981</Sl>
							<Sl Kod="23">Qrwvnqtqwj</Sl>
							<Sl Kod="24">15</Sl>
							<Sl Kod="25">45</Sl>
							<Sl Kod="26">Xrlrlhosja</Sl>
							<Sl Kod="27">10000</Sl>
							<Sl Kod="28">CZ</Sl>
							<Sl Kod="29">Fosdvagekm</Sl>
							<Sl Kod="30">20</Sl>
							<Sl Kod="31">12</Sl>
							<Sl Kod="32">Jkxklkwuee</Sl>
							<Sl Kod="33">11100</Sl>
							<Sl Kod="34">CZ</Sl>
						</Ra>
					</DataDo>
					<DataDo Kod="CEU10_21">
						<Ra Kod="1" Poradi="1">
							<Sl Kod="1">123</Sl>
							<Sl Kod="2">100001</Sl>
							<Sl Kod="3">1111111111</Sl>
							<Sl Kod="4">20.02.1984</Sl>
						</Ra>
					</DataDo>
				</DatoveOblasti>
			</DataFormatSdatXml>
		</DataVydani>
	</Vydani>
</zvz:DataVstupniZpravy>

Krok 2 - zaslání vstupní zprávy do systému SDAT
Cílem tohoto kroku je předání Vstupní zprávy do zpracování v ČNB.  Tento krok je realizován zavoláním webové služby ZaslaniVstupniZpravy.
Soubor ve formátu XML připravený v předchozím kroku a představující Vydání výkazu je nutné komprimovat metodou GZIP a vložit jako base64[footnoteRef:2] do elementu Data. [2:  V nástroji SoapUI lze v elementu Data vyvolat kontextové menu „Insert file as Base64“] 

Příklad požadavku na službu ZaslaniVstupniZpravy:
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:urn="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1" xmlns:xd="http://www.w3.org/2000/09/xmldsig#" xmlns:xm="http://www.w3.org/2005/05/xmlmime">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:ZaslaniVstupniZpravyRequest>
         <ZadostInfo>
            <CasZadosti>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</CasZadosti>
            <ZadostId>${=UUID.randomUUID()}</ZadostId>
            <VerzeZadosti>1.0.0</VerzeZadosti>
            <OsobaKod>9999</OsobaKod>        
         </ZadostInfo>
         <Zadost>
            <VstupniZprava>
               <HlavickaZpravy>
                  <ReferencniId>223</ReferencniId>
                  <ZasilajiciOsoba>9999</ZasilajiciOsoba>
                  <DatumVytvoreni>2019-06-11T23:00:00</DatumVytvoreni>
               </HlavickaZpravy>
               <TeloZpravy>
                  <VlozenaData>                     <Data></Data>
                  </VlozenaData>
               </TeloZpravy>
            </VstupniZprava>
         </Zadost>
      </urn:ZaslaniVstupniZpravyRequest>
   </soapenv:Body>
</soapenv:Envelope>

Krok 3 – odpověď systému SDAT na zaslání vstupní zprávy 
V případě úspěšného zavolání webové služby ZaslaniVstupniZpravy je synchronně vrácena odpověď, která obsahuje výsledek této akce <VysledekKod>OK</VysledekKod> a jedinečný identifikátor VstupníZpravy přidělený systémem SDAT (<VstupniZpravaId>).
Příklad odpovědi webové služby ZaslaniVstupniZpravy:

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
   <SOAP-ENV:Header>
   </SOAP-ENV:Header>
   <SOAP-ENV:Body>
      <zvz:ZaslaniVstupniZpravyResponse xsi:schemaLocation="urn:cz:cnb:sdat:schemas:CtiVykaz:v1 xsd/informacni_sluzby/CtiVykaz.xsd
urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1 xsd/informacni_sluzby/CtiSeznamVykazu.xsd
urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1 xsd/informacni_sluzby/CtiVykazovaciPovinnost.xsd
urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1 xsd/informacni_sluzby/CtiUdajeOsoby.xsd
urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1 xsd/informacni_sluzby/CtiStavVykazovani.xsd
urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1 xsd/informacni_sluzby/CtiStavZpracovani.xsd
urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1 xsd/vykazovaci_sluzby/ZaslaniVstupniZpravy.xsd
urn:cz:cnb:sdat:schemas:DatoveTypy:v1 xsd/common/DatoveTypy.xsd
urn:cz:cnb:sdat:schemas:ObjektyTypy:v1 xsd/common/ObjektyTypy.xsd
urn:cz:cnb:sdat:schemas:SystemTypy:v1 xsd/common/SystemTypy.xsd
urn:cz:cnb:sdat:schemas:SpecialniTypy:v1 xsd/common/SpecialniTypy.xsd
urn:cz:cnb:sdat:schemas:SpolecneTypy:v1 xsd/common/SpolecneTypy.xsd" xmlns:csv="urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1" xmlns:csvy="urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1" xmlns:csz="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1" xmlns:cuo="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1" xmlns:cvp="urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1" xmlns:cvy="urn:cz:cnb:sdat:schemas:CtiVykaz:v1" xmlns:czv="urn:cz:cnb:sdat:schemas:CtiZmenyVykazu:v1" xmlns:ds="http://www.w3.org/2000/09/xmldsig#" xmlns:ns11="urn:cz:cnb:sdat:schemas:Protokoly:v1" xmlns:obj="urn:cz:cnb:sdat:schemas:ObjektyTypy:v1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:zvz="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1">
         <OdpovedInfo>
            <CasOdpovedi>2019-06-19T09:58:17.148</CasOdpovedi>
            <ZadostId>72fd645f-2df1-4c13-8698-87925326db34</ZadostId>
            <VerzeSluzby>1.0.0</VerzeSluzby>
            <Status>
               <VysledekKod>OK</VysledekKod>
            </Status>
         </OdpovedInfo>
         <Odpoved>
            <ReferencniId>223</ReferencniId>
            <ZasilajiciOsoba>9999</ZasilajiciOsoba>
            <OtiskVstupniZpravy>
               <TypOtisku>SHA256</TypOtisku>
               <Otisk>c590da228e8f35f89fb488d38698997c516a805ca815ad2c43094d72016c908f</Otisk>
            </OtiskVstupniZpravy>
            <VysledekPrijeti>
               <Vysledek>PRIJATO</Vysledek>
               <VstupniZpravaId>9596821</VstupniZpravaId>
            </VysledekPrijeti>
         </Odpoved>
      </zvz:ZaslaniVstupniZpravyResponse>
   </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

Krok 4 – dotázání systému SDAT na stav zpracování Vstupní zprávy a vydání
Cílem tohoto kroku je získat informace o stavu zpracování Vstupní zprávy a protokol. K získání těchto informací je třeba zavolat webovou službu CtiStavZpracovani. 

V požadavku je nutné uvést jedinečný identifikátor přidělený systémem SDAT (VstupniZpravaId) vrácený v response předchozího kroku.
Příklad požadavku na službu CtiStavZpracovani:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:urn="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:CtiStavZpracovaniRequest>
         <ZadostInfo>
            <CasZadosti>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</CasZadosti>
            <ZadostId>${=UUID.randomUUID()}</ZadostId>
            <VerzeZadosti>1.0.0</VerzeZadosti>
            <OsobaKod>9999</OsobaKod>            
         </ZadostInfo>
         <Dotaz>
            <VstupniZpravaId>9596821</VstupniZpravaId>
            <ZahrnoutProtokolVstupniZpravy>true</ZahrnoutProtokolVstupniZpravy>
            <ZahrnoutProtokolyJvk>false</ZahrnoutProtokolyJvk>
            <ZahrnoutProtokolyMvk>false</ZahrnoutProtokolyMvk>
         </Dotaz>
      </urn:CtiStavZpracovaniRequest>
   </soapenv:Body>
</soapenv:Envelope>

Krok 5 - získání informace o stavu zpracování Vstupní zprávy v systému SDAT 
Službu CtiStavZpracovani lze volat opakovaně a v čase vrací průběžné výsledky zpracování v systému SDAT. Jako první je dostupná informace o stavu vstupní zprávy, přičemž první pozitivní stav v pořadí je „PRIJATO“. 

Příklad odpovědi služby CtiStavZpracovani:

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
   <SOAP-ENV:Header>
   </SOAP-ENV:Header>
   <SOAP-ENV:Body>
      <csz:CtiStavZpracovaniResponse xsi:schemaLocation="urn:cz:cnb:sdat:schemas:CtiVykaz:v1 xsd/informacni_sluzby/CtiVykaz.xsd
urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1 xsd/informacni_sluzby/CtiSeznamVykazu.xsd
urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1 xsd/informacni_sluzby/CtiVykazovaciPovinnost.xsd
urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1 xsd/informacni_sluzby/CtiUdajeOsoby.xsd
urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1 xsd/informacni_sluzby/CtiStavVykazovani.xsd
urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1 xsd/informacni_sluzby/CtiStavZpracovani.xsd
urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1 xsd/vykazovaci_sluzby/ZaslaniVstupniZpravy.xsd
urn:cz:cnb:sdat:schemas:DatoveTypy:v1 xsd/common/DatoveTypy.xsd
urn:cz:cnb:sdat:schemas:ObjektyTypy:v1 xsd/common/ObjektyTypy.xsd
urn:cz:cnb:sdat:schemas:SystemTypy:v1 xsd/common/SystemTypy.xsd
urn:cz:cnb:sdat:schemas:SpecialniTypy:v1 xsd/common/SpecialniTypy.xsd
urn:cz:cnb:sdat:schemas:SpolecneTypy:v1 xsd/common/SpolecneTypy.xsd" xmlns:csv="urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1" xmlns:csvy="urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1" xmlns:csz="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1" xmlns:cuo="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1" xmlns:cvp="urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1" xmlns:cvy="urn:cz:cnb:sdat:schemas:CtiVykaz:v1" xmlns:czv="urn:cz:cnb:sdat:schemas:CtiZmenyVykazu:v1" xmlns:ds="http://www.w3.org/2000/09/xmldsig#" xmlns:ns11="urn:cz:cnb:sdat:schemas:Protokoly:v1" xmlns:obj="urn:cz:cnb:sdat:schemas:ObjektyTypy:v1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:zvz="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1">
         <OdpovedInfo>
            <CasOdpovedi>2019-06-19T10:00:23.751</CasOdpovedi>
            <ZadostId>dc8dfbc8-674a-4f8d-b69d-3084ab5f0b3c</ZadostId>
            <VerzeSluzby>1.0.0</VerzeSluzby>
            <Status>
               <VysledekKod>OK</VysledekKod>
            </Status>
         </OdpovedInfo>
         <Dotaz>
            <VstupniZpravaId>9596821</VstupniZpravaId>
            <ZahrnoutProtokolVstupniZpravy>true</ZahrnoutProtokolVstupniZpravy>
            <ZahrnoutProtokolyJvk>false</ZahrnoutProtokolyJvk>
            <ZahrnoutProtokolyMvk>false</ZahrnoutProtokolyMvk>
         </Dotaz>
         <Odpoved>
            <StavZpracovani>
               <VstupniZpravaId>9596821</VstupniZpravaId>
               <ReferencniId>223</ReferencniId>
               <ZasilajiciOsoba>9999</ZasilajiciOsoba>
               <DatumVytvoreni>2019-06-11T23:00:00</DatumVytvoreni>
               <StavVstupniZpravy>PRIJATO</StavVstupniZpravy>
            </StavZpracovani>
         </Odpoved>
      </csz:CtiStavZpracovaniResponse>
   </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

Krok 6 - získání protokolu Vstupní zprávy v systému SDAT 
Následně s časovou prodlevou závislou na množství zpracovávaných zpráv ve vstupní frontě systému SDAT je dostupná informace o tom, že bylo dokončeno zpracování vstupní zprávy. Současně obsahuje i protokol ke vstupní zprávě, informující zda bylo Vydání výskytu výkazu zařazeno do dalšího zpracování.  Iniciální pozitivní stav je pro Vydání výskytu výkazu hodnota „ZALOZENO“. Odpověď uvedená níže je výsledkem stejného dotazu jako v předchozím kroku, tj. dotaz krok 4.


<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
   <SOAP-ENV:Header>
      <!--generated on TEST 2019-06-25T13:25:28.709 by 0.53.0-2019-06-24T11:10:38Z-->
   </SOAP-ENV:Header>
   <SOAP-ENV:Body>
      <csz:CtiStavZpracovaniResponse xsi:schemaLocation="urn:cz:cnb:sdat:schemas:CtiVykaz:v1 xsd/informacni_sluzby/CtiVykaz.xsd
urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1 xsd/informacni_sluzby/CtiSeznamVykazu.xsd
urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1 xsd/informacni_sluzby/CtiVykazovaciPovinnost.xsd
urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1 xsd/informacni_sluzby/CtiUdajeOsoby.xsd
urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1 xsd/informacni_sluzby/CtiStavVykazovani.xsd
urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1 xsd/informacni_sluzby/CtiStavZpracovani.xsd
urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1 xsd/vykazovaci_sluzby/ZaslaniVstupniZpravy.xsd
urn:cz:cnb:sdat:schemas:DatoveTypy:v1 xsd/common/DatoveTypy.xsd
urn:cz:cnb:sdat:schemas:ObjektyTypy:v1 xsd/common/ObjektyTypy.xsd
urn:cz:cnb:sdat:schemas:SystemTypy:v1 xsd/common/SystemTypy.xsd
urn:cz:cnb:sdat:schemas:SpecialniTypy:v1 xsd/common/SpecialniTypy.xsd
urn:cz:cnb:sdat:schemas:SpolecneTypy:v1 xsd/common/SpolecneTypy.xsd" xmlns:csv="urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1" xmlns:csvy="urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1" xmlns:csz="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1" xmlns:cuo="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1" xmlns:cvp="urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1" xmlns:cvy="urn:cz:cnb:sdat:schemas:CtiVykaz:v1" xmlns:czv="urn:cz:cnb:sdat:schemas:CtiZmenyVykazu:v1" xmlns:ds="http://www.w3.org/2000/09/xmldsig#" xmlns:ns11="urn:cz:cnb:sdat:schemas:Protokoly:v1" xmlns:obj="urn:cz:cnb:sdat:schemas:ObjektyTypy:v1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:zvz="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1">
         <OdpovedInfo>
            <CasOdpovedi>2019-06-25T13:25:28.704</CasOdpovedi>
            <ZadostId>167d877f-f880-4db7-a819-3a1788298bd7</ZadostId>
            <VerzeSluzby>1.0.0</VerzeSluzby>
            <Status>
               <VysledekKod>OK</VysledekKod>
            </Status>
         </OdpovedInfo>
         <Dotaz>
            <VstupniZpravaId>9596821</VstupniZpravaId>
            <ZahrnoutProtokolVstupniZpravy>true</ZahrnoutProtokolVstupniZpravy>
            <ZahrnoutProtokolyJvk>true</ZahrnoutProtokolyJvk>
            <ZahrnoutProtokolyMvk>true</ZahrnoutProtokolyMvk>
         </Dotaz>
         <Odpoved>
            <StavZpracovani>
               <VstupniZpravaId>9596821</VstupniZpravaId>
               <ReferencniId>224</ReferencniId>
               <ZasilajiciOsoba>9999</ZasilajiciOsoba>
               <DatumVytvoreni>2019-06-25T13:21:00</DatumVytvoreni>
               <StavVstupniZpravy>DOKONCENO</StavVstupniZpravy>
               <ProtokolZpracovaniZpravy>
                  <CasVytvoreni>2019-06-25T13:22:39.136</CasVytvoreni>
                  <Typ>VZ</Typ>
                  <Nazev>Protokol o zpracování vstupní zprávy</Nazev>
                  <Format>XML</Format>
                  <Stav>ODESLANO</Stav>
                  <StavOd>2019-06-25T13:22:39.136</StavOd>
                  <Obsah>
                     <Data>
                        <xop:Include href="cid:3cb4c1ff-2ea9-4739-bfd9-f59395d5488e%40null" xmlns:xop="http://www.w3.org/2004/08/xop/include"/>
                     </Data>
                  </Obsah>
               </ProtokolZpracovaniZpravy>
               <VydaniStav>
                  <HlavickaPrijatehoVydani>
                     <VydaniId>2464365</VydaniId>
                     <VykazKod>CEUSIFE10</VykazKod>
                     <VykazNazev>Denní přehled změn v účtech vedených úvěrovou institucí</VykazNazev>
                     <OsobaKod>9999</OsobaKod>
                     <OsobaNazev>Technologický subjekt</OsobaNazev>
                     <StavKeDni>2019-06-28</StavKeDni>
                     <RozsahKod>S_BCPZB</RozsahKod>
                     <MetodikaKod>CEU20190101.1</MetodikaKod>
                     <Format>XMLSDAT</Format>
                     <CisloVydani>1</CisloVydani>
                     <TypVydani>DATA</TypVydani>
                     <DatumPrijetiVydani>2019-06-25T13:22:29.031</DatumPrijetiVydani>
                  </HlavickaPrijatehoVydani>
                  <StavVydani>ZALOZENO</StavVydani>
               </VydaniStav>
            </StavZpracovani>
         </Odpoved>
      </csz:CtiStavZpracovaniResponse>
   </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

Krok 7 - získání protokolu o zpracování Vydání výskytu výkazu v systému SDAT
Po dalším volání stejného dotazu (krok 4) již odpověď obsahuje informaci o dokončení zpracování Vydání výskytu výkazu (stav „DOKONCENO“) a součástí odpovědi je i jeho protokol.

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
   <SOAP-ENV:Header>
      <!--generated on AKC 2019-06-25T10:47:43.546 by 0.53.0-2019-06-24T11:10:38Z-->
   </SOAP-ENV:Header>
   <SOAP-ENV:Body>
      <csz:CtiStavZpracovaniResponse xsi:schemaLocation="urn:cz:cnb:sdat:schemas:CtiVykaz:v1 xsd/informacni_sluzby/CtiVykaz.xsd
urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1 xsd/informacni_sluzby/CtiSeznamVykazu.xsd
urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1 xsd/informacni_sluzby/CtiVykazovaciPovinnost.xsd
urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1 xsd/informacni_sluzby/CtiUdajeOsoby.xsd
urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1 xsd/informacni_sluzby/CtiStavVykazovani.xsd
urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1 xsd/informacni_sluzby/CtiStavZpracovani.xsd
urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1 xsd/vykazovaci_sluzby/ZaslaniVstupniZpravy.xsd
urn:cz:cnb:sdat:schemas:DatoveTypy:v1 xsd/common/DatoveTypy.xsd
urn:cz:cnb:sdat:schemas:ObjektyTypy:v1 xsd/common/ObjektyTypy.xsd
urn:cz:cnb:sdat:schemas:SystemTypy:v1 xsd/common/SystemTypy.xsd
urn:cz:cnb:sdat:schemas:SpecialniTypy:v1 xsd/common/SpecialniTypy.xsd
urn:cz:cnb:sdat:schemas:SpolecneTypy:v1 xsd/common/SpolecneTypy.xsd" xmlns:csv="urn:cz:cnb:sdat:schemas:CtiSeznamVykazu:v1" xmlns:csvy="urn:cz:cnb:sdat:schemas:CtiStavVykazovani:v1" xmlns:csz="urn:cz:cnb:sdat:schemas:CtiStavZpracovani:v1" xmlns:cuo="urn:cz:cnb:sdat:schemas:CtiUdajeOsoby:v1" xmlns:cvp="urn:cz:cnb:sdat:schemas:CtiVykazovaciPovinnost:v1" xmlns:cvy="urn:cz:cnb:sdat:schemas:CtiVykaz:v1" xmlns:czv="urn:cz:cnb:sdat:schemas:CtiZmenyVykazu:v1" xmlns:ds="http://www.w3.org/2000/09/xmldsig#" xmlns:ns11="urn:cz:cnb:sdat:schemas:Protokoly:v1" xmlns:obj="urn:cz:cnb:sdat:schemas:ObjektyTypy:v1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:zvz="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1">
         <OdpovedInfo>
            <CasOdpovedi>2019-06-25T10:47:43.538</CasOdpovedi>
            <ZadostId>fe36dc6d-8de9-4f47-a379-0b6bfc09f5c1</ZadostId>
            <VerzeSluzby>1.0.0</VerzeSluzby>
            <Status>
               <VysledekKod>OK</VysledekKod>
            </Status>
         </OdpovedInfo>
         <Dotaz>
            <VstupniZpravaId>9596821</VstupniZpravaId>
            <ZahrnoutProtokolVstupniZpravy>true</ZahrnoutProtokolVstupniZpravy>
            <ZahrnoutProtokolyJvk>true</ZahrnoutProtokolyJvk>
            <ZahrnoutProtokolyMvk>true</ZahrnoutProtokolyMvk>
         </Dotaz>
         <Odpoved>
            <StavZpracovani>
               <VstupniZpravaId>9596821</VstupniZpravaId>
               <ReferencniId>98989000004</ReferencniId>
               <ZasilajiciOsoba>9999</ZasilajiciOsoba>
               <DatumVytvoreni>2019-06-25T10:37:18.968</DatumVytvoreni>
               <StavVstupniZpravy>DOKONCENO</StavVstupniZpravy>
               <ProtokolZpracovaniZpravy>
                  <CasVytvoreni>2019-06-25T10:42:10.227</CasVytvoreni>
                  <Typ>VZ</Typ>
                  <Nazev>Protokol o zpracování vstupní zprávy</Nazev>
                  <Format>XML</Format>
                  <Stav>ZALOZENO</Stav>
                  <StavOd>2019-06-25T10:42:10.227</StavOd>
                  <Obsah>
                     <Data>
                        <xop:Include href="cid:7afbeb42-f931-42d7-9d6c-abc9822d0024%40null" xmlns:xop="http://www.w3.org/2004/08/xop/include"/>
                     </Data>
                  </Obsah>
               </ProtokolZpracovaniZpravy>
               <VydaniStav>
                  <HlavickaPrijatehoVydani>
                     <VydaniId>2464365</VydaniId>
                     <VykazKod>CEUSIFE10</VykazKod>
                     <VykazNazev>Denní přehled změn v účtech vedených úvěrovou institucí</VykazNazev>
                     <OsobaKod>98989</OsobaKod>
                     <OsobaNazev>První vykazující, a. s.</OsobaNazev>
                     <StavKeDni>2019-06-28</StavKeDni>
                     <RozsahKod>S_BCPZB</RozsahKod>
                     <MetodikaKod>CEU20190101.1</MetodikaKod>
                     <Format>XMLSDAT</Format>
                     <CisloVydani>1</CisloVydani>
                     <TypVydani>DATA</TypVydani>
                     <DatumPrijetiVydani>2019-06-25T10:42:00.213</DatumPrijetiVydani>
                  </HlavickaPrijatehoVydani>
                  <StavVydani>DOKONCENO</StavVydani>
                  <ProtokolZpracovaniVydani>
                     <CasVytvoreni>2019-06-25T10:46:51.483</CasVytvoreni>
                     <Typ>VYD</Typ>
                     <Nazev>Protokol o zpracování vstupní vydání výskytu výkazu</Nazev>
                     <Format>XML</Format>
                     <Stav>ZALOZENO</Stav>
                     <StavOd>2019-06-25T10:46:51.483</StavOd>
                     <Obsah>
                        <Data>
                           <xop:Include href="cid:f99a2b2e-d904-4df8-b8f2-d263bf370330%40null" xmlns:xop="http://www.w3.org/2004/08/xop/include"/>
                        </Data>
                     </Obsah>
                  </ProtokolZpracovaniVydani>
               </VydaniStav>
            </StavZpracovani>
         </Odpoved>
      </csz:CtiStavZpracovaniResponse>
   </SOAP-ENV:Body>
</SOAP-ENV:Envelope>


Krok 8 – získání protokolů o zpracování Vstupní zprávy a Vydání výskytu výkazu
Protokoly jsou zaslány jako MTOM příloha response služby CtiStavZpracovani. V době testování je předáváno plain XML oproti deklarovanému GZIP. 
[image: ]
[bookmark: _Toc41288807]Scénář TEST_1.2 zaslání podepsaného výkazu CEUSIFE10
Vzorové soubory pro tento testovací scénář jsou k dispozici na webu a zahrnují:
· SDAT_VYD_9898920190827140948547.gzip – komprimovaná data Vstupní zprávy
· SDAT_VYD_9898920190827140948547.gzip.seal.xml – soubor s elektronickým podpisem
· SDAT_CtiStavZpracovani_Protokol_VZ.seal.env.xml – ukázka systémem SDAT podepsaného protokolu Vstupní zprávy 
Cílem testu je: 
· Odeslat podepsaná data Vstupní zprávy obsahující jedno Vydání výskytu výkazu za výkaz CEUSIFE10 ve verzi metodiky CEU20190101.1. 
· Na základě získaných vstupních zpráv a odpovídajících podpisů bude na straně SDAT testováno ověřování podpisů.. 
Krok 1 – příprava souboru pro podpis
Použijte XML soubor z TEST_1.1 krok 1. Soubor komprimujte metodou GZIP – vznikne soubor, který je nutné pojmenovat dle konvence SDAT_VYD_<ReferencniId>.gzip, kde ReferencniId odpovídá hodnotě elementu <ReferencniId> Vstupní zprávy, např. SDAT_VYD_9898920190827140948547.gzip. 
Krok 2 – vytvoření elektronického podpisu
Soubor SDAT_VYD_9898920190827140948547.gzip opatřete elektronickým podpisem podle standardu PKCS#7(XAdES, No Container, Detached, BASELINE-B). Pro testovací účely lze použít např. nástroj https://joinup.ec.europa.eu/dss-webapp/sign-a-document nebo utilitu https://www.cnb.cz/cs/statistika/sdat/sdat-podpis/index.html. V obou případech vznikne samostatný XML soubor s podpisem, např. SDAT_VYD_9898920190827140948547.seal.xml.
Krok 3 - zaslání vstupní zprávy do systému SDAT
Krok spočívá v zavolání webové služby ZaslaniVstupniZpravy.
Soubory s daty a podpisem připravené v předchozích krocích je nutné vložit jako base64 do elementů Podpis a Data.
Příklad požadavku na službu ZaslaniVstupniZpravy:
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:urn="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1" xmlns:xd="http://www.w3.org/2000/09/xmldsig#" xmlns:xm="http://www.w3.org/2005/05/xmlmime">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:ZaslaniVstupniZpravyRequest>
         <ZadostInfo>
            <CasZadosti>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</CasZadosti>
            <ZadostId>${=UUID.randomUUID()}</ZadostId>
            <VerzeZadosti>1.0.0</VerzeZadosti>
            <OsobaKod>9999</OsobaKod>
            <Uzivatel>u04610</Uzivatel>
         </ZadostInfo>
         <Zadost>
            <VstupniZprava>
               <HlavickaZpravy>
                  <ReferencniId>9898920190820135548835</ReferencniId>
                  <ZasilajiciOsoba>9999</ZasilajiciOsoba>
                  <DatumVytvoreni>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</DatumVytvoreni>
                  <Podpis>…<!-- …kráceno…--></Podpis>
               </HlavickaZpravy>
               <TeloZpravy>
                  <VlozenaData>
				<Data></Data>
                  </VlozenaData>
               </TeloZpravy>
            </VstupniZprava>
         </Zadost>
      </urn:ZaslaniVstupniZpravyRequest>
   </soapenv:Body>
</soapenv:Envelope> 

Krok 4 – ověření stavu zpracování
Odpovídá krokům 3 a dalším uvedeným v TEST_1.1. 
[bookmark: _Ref31702561][bookmark: _Toc41288808]TEST_2 – Vykazování XBRL
[bookmark: _Toc41288809]Scénář TEST_2.1 zaslání XBRL instance 
Cílem testu je: 
· Odeslat Vstupní zprávu obsahující XBRL instanci 
· Přečíst informace o stavu validace v protokolu
Krok 1 – data ve formátu XBRL
Vykazující osoba musí mít nástroj, který generuje XBRL instanci dle specifikace XBRL a podle taxonomie pro příslušný výkaz. XBRL instanci nelze získat exportem ze systému SDAT. 
Krok 2 - zaslání vstupní zprávy do systému SDAT
Cílem tohoto kroku je předání Vstupní zprávy do zpracování v ČNB.  Tento krok je realizován zavoláním webové služby ZaslaniVstupniZpravy.
Soubor ve formátu XBRL připravený v předchozím kroku a představující Vydání výkazu je nutné komprimovat metodou ZIP a vložit jako base64 do elementu Data.
Příklad požadavku na službu ZaslaniVstupniZpravy:
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:urn="urn:cz:cnb:sdat:schemas:ZaslaniVstupniZpravy:v1">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:ZaslaniVstupniZpravyRequest>
         <ZadostInfo>
            <CasZadosti>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</CasZadosti>
            <ZadostId>${=UUID.randomUUID()}</ZadostId>
            <VerzeZadosti>1.0.0</VerzeZadosti>
            <OsobaKod>98989</OsobaKod>
         </ZadostInfo>
         <Zadost>
            <VstupniZprava>
               <HlavickaZpravy>
                  <ReferencniId>9999202002020001</ReferencniId>
                  <ZasilajiciOsoba>9999</ZasilajiciOsoba>
                  <DatumVytvoreni>${=new Date().format("yyyy-MM-dd'T'HH:mm:ss.SSS")}</DatumVytvoreni>
     <Podpis>PGRzOlNpZ250iX1NFX2NlZmM4ODU5LTUxODYt… kráceno</Podpis>
               </HlavickaZpravy>
               <TeloZpravy>
                  <VlozenaData>
                     <Data>H4sICPNb+10AAHFlcy54bWwAjLrXruzKlSX6… kráceno</Data>
                  </VlozenaData>
               </TeloZpravy>
            </VstupniZprava>
         </Zadost>
      </urn:ZaslaniVstupniZpravyRequest>
   </soapenv:Body>
</soapenv:Envelope>

Krok 3 – ukázka protokolu s výsledkem XBRL validace 
Pomocí webové služby CtiStavZpracovani lze získat protokol o zpracování vydání. Klíčová informace o výsledku je uvedena v elementu <ns2:IsXbrlValid> (true|false). I v případě true se dále v protokolu mohou v <ns2:ValidationResults> vyskytovat chyby kategorie varování (severity = warning). 
<?xml version="1.0" encoding="UTF-8"?>
<ns2:GetProcessingResultResult xmlns:ns2="http://amana.xbrl.service/version/1003" xmlns="http://schemas.microsoft.com/2003/10/Serialization/Arrays" xmlns:ns3="http://schemas.datacontract.org/2004/07/AMANA.XBRL.Portal.Common">
    <ns2:DuplicateFilingId xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:nil="true"/>
    <ns2:DuplicateFilingXbrlProcessingId xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:nil="true"/>
    <ns2:FilingId xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:nil="true"/>
    <ns2:FilingVersionId xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:nil="true"/>
    <ns2:IsDuplicateFiling xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:nil="true"/>
    <ns2:IsRejected xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:nil="true"/>
    <ns2:IsServerError>false</ns2:IsServerError>
    <ns2:IsXbrlValid>true</ns2:IsXbrlValid>
    <ns2:Md5Hash>F773126E2D5EA7881163292D860C21D4</ns2:Md5Hash>
    <ns2:ProcessingId>9b11243d-c2d5-4eb7-81c1-b1ead973ba75</ns2:ProcessingId>
    <ns2:Status>RanToCompletion</ns2:Status>
    <ns2:ValidationResults>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV981-4</ns3:Id>
            <ns3:Message>BV981-4: not(empty(SE.06.02.16.02,c0200)) where not(matches(SE.06.02.16.02,c0290,"^..((71)|(75)|(9.)|(09))$"))</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV815-2</ns3:Id>
            <ns3:Message>BV815-2: empty(S.08.02.01.02,c0360) where not(matches(S.08.02.01.02,c0320,"^..((D2)|(D3))$"))</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV782-4</ns3:Id>
            <ns3:Message>BV782-4: empty(SE.06.02.16.01,c0160) where matches(SE.06.02.16.02,c0290,"^..((7)|(8)).$")</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV782-4</ns3:Id>
            <ns3:Message>BV782-4: empty(SE.06.02.16.01,c0160) where matches(SE.06.02.16.02,c0290,"^..((7)|(8)).$")</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV782-4</ns3:Id>
            <ns3:Message>BV782-4: empty(SE.06.02.16.01,c0160) where matches(SE.06.02.16.02,c0290,"^..((7)|(8)).$")</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV782-4</ns3:Id>
            <ns3:Message>BV782-4: empty(SE.06.02.16.01,c0160) where matches(SE.06.02.16.02,c0290,"^..((7)|(8)).$")</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
        <ns3:ValidationResult>
            <ns3:ErrorSubType>None</ns3:ErrorSubType>
            <ns3:ErrorType>None</ns3:ErrorType>
            <ns3:Id>s2md_BV782-4</ns3:Id>
            <ns3:Message>BV782-4: empty(SE.06.02.16.01,c0160) where matches(SE.06.02.16.02,c0290,"^..((7)|(8)).$")</ns3:Message>
            <ns3:Severity>Warning</ns3:Severity>
            <ns3:Type>Xbrl</ns3:Type>
        </ns3:ValidationResult>
    </ns2:ValidationResults>
    <ds:Signature xmlns:ds="http://www.w3.org/2000/09/xmldsig#" Id="_SE_72099a3f-52b7-4d">
        <ds:SignedInfo>
            <ds:CanonicalizationMethod Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#"/>
            <ds:SignatureMethod Algorithm="http://www.w3.org/2001/04/xmldsig-more#rsa-sha512"/>
            <ds:Reference URI="">
                <ds:Transforms>
                    <ds:Transform Algorithm="http://www.w3.org/2000/09/xmldsig#enveloped-signature"/>
                    <ds:Transform Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#"/>
                </ds:Transforms>
                <ds:DigestMethod Algorithm="http://www.w3.org/2001/04/xmlenc#sha256"/>
                <ds:DigestValue>kAi+w8vzmI3EpVRX91Urd0RMQYZ3oCSQ+Yt6GuD+Ac4=</ds:DigestValue>
            </ds:Reference>
            <ds:Reference Type="http://uri.etsi.org/01903#SignedProperties" URI="#_SignedProperties_981ce866-7ad9-40">
                <ds:Transforms>
                    <ds:Transform Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#"/>
                </ds:Transforms>
                <ds:DigestMethod Algorithm="http://www.w3.org/2001/04/xmlenc#sha256"/>
                <ds:DigestValue>t1c02ZehVVq3B2TsyNgjI/4Pgi4arG376JXmddlOGys=</ds:DigestValue>
            </ds:Reference>
        </ds:SignedInfo>
        <ds:SignatureValue>Np1IGI7lyt2enSGKXhAGh0V/y6A5/vnfitQHE8zmC52MU/KZnT35A18I6LVyvHQppXa2JxBgW2Zf 6v+/AFwH6xjfURTZO9gE1BimSgfyXUIGu1kVxeOPxfTZ3lEmEt8Wry/08lgcOGfa6TLr7AxuSJQb upy4M8XAfGZEZaHrrTdk4kG9dimtseV/q5xsUOYNbwjnLL04IRI5dw5gRoiZ12vrFGyezylx+cob OGGK6Nszfk7vAGaGe17HGpMKpJqEpnzNvyBPfymVy2fzC8ntiFwaVUiOHaNMWzgMLi+jnFViPKok s+XfXhvnLPiOXUtw4bHwtNJPX2gLPu+UqrUWVQ==</ds:SignatureValue>
        <ds:KeyInfo>
            <ds:X509Data>
                <ds:X509IssuerSerial>
                    <ds:X509IssuerName>CN=PostSignum Qualified CA 3,O=ÄŚeskĂˇ poĹˇta\, s.p. [IÄŚ 47114983],C=CZ</ds:X509IssuerName>
                    <ds:X509SerialNumber>5043793</ds:X509SerialNumber>
                </ds:X509IssuerSerial>
                <ds:X509SubjectName>2.5.4.5=#1306533136363736,CN=SDAT,O=ÄŚeskĂˇ nĂˇrodnĂ­ banka [IÄŚ 48136450],2.5.4.97=#130e4e5452435a2d3438313336343530,C=CZ</ds:X509SubjectName>
                <ds:X509Certificate>MIIHRDCCBiygAwIBAgIDTPZRMA0GCSqGSIb3DQEBCwUAMF8xCzAJBgNVBAYTAkNaMSwwKgYDVQQK DCPEjGVza8OhIHBvxaF0YSwgcy5wLiBbScSMIDQ3MTE0OTgzXTEiMCAGA1UEAxMZUG9zdFNpZ251 bSBRdWFsaWZpZWQgQ0EgMzAeFw0xOTAyMjIwOTI2MDBaFw0yMDAyMjIwOTI2MDBaMHcxCzAJBgNV BAYTAkNaMRcwFQYDVQRhEw5OVFJDWi00ODEzNjQ1MDEvMC0GA1UECgwmxIxlc2vDoSBuw6Fyb2Ru w60gYmFua2EgW0nEjCA0ODEzNjQ1MF0xDTALBgNVBAMTBFNEQVQxDzANBgNVBAUTBlMxNjY3NjCC ASIwDQYJKoZIhvcNAQEBBQADggEPADCCAQoCggEBAKcyPheoGeBrthiFIz/e4tIXhNmwT3XxH5d7 B9vu5oPVMRU7nr2ibsDTqSXD5SKhl+uJ/hiZERO3yIhMhE5eCGqo4tyvX0ilIfN0K/wofS5b0iUO 6R/QyezkVt6vWcWT4pt7QXEJiK6/KB0nB/raNpnf11Q3B2o3K2kqn21M1Ss7SrC15tkRSk3jUDP5 dfMb6URIDjJ8c2xw+n5qxs67PnfyD88ppM/loqwBjNK3j5tzUicXnplZCZ9jjijZFnq8R/M7IPTs ZJo1v6/IBtFzyJTieLLWHOWL3KyTX9bcLcoYcgWVkTsiW56sI20mLmLYJKzsFMw/iyfqbhhC0od4 7rUCAwEAAaOCA+8wggPrMCEGA1UdEQQaMBiBC3NkYXRAY25iLmN6oAkGA1UEDaACEwAwggElBgNV HSAEggEcMIIBGDCCAQkGCGeBBgEEARJ4MIH8MIHTBggrBgEFBQcCAjCBxhqBw1RlbnRvIGt2YWxp Zmlrb3ZhbnkgY2VydGlmaWthdCBwcm8gZWxla3Ryb25pY2tvdSBwZWNldCBieWwgdnlkYW4gdiBz b3VsYWR1IHMgbmFyaXplbmltIEVVIGMuIDkxMC8yMDE0LlRoaXMgaXMgYSBxdWFsaWZpZWQgY2Vy dGlmaWNhdGUgZm9yIGVsZWN0cm9uaWMgc2VhbCBhY2NvcmRpbmcgdG8gUmVndWxhdGlvbiAoRVUp IE5vIDkxMC8yMDE0LjAkBggrBgEFBQcCARYYaHR0cDovL3d3dy5wb3N0c2lnbnVtLmN6MAkGBwQA i+xAAQEwgZsGCCsGAQUFBwEDBIGOMIGLMAgGBgQAjkYBATBqBgYEAI5GAQUwYDAuFihodHRwczov L3d3dy5wb3N0c2lnbnVtLmN6L3Bkcy9wZHNfZW4ucGRmEwJlbjAuFihodHRwczovL3d3dy5wb3N0 c2lnbnVtLmN6L3Bkcy9wZHNfY3MucGRmEwJjczATBgYEAI5GAQYwCQYHBACORgEGAjCB+gYIKwYB BQUHAQEEge0wgeowOwYIKwYBBQUHMAKGL2h0dHA6Ly93d3cucG9zdHNpZ251bS5jei9jcnQvcHNx dWFsaWZpZWRjYTMuY3J0MDwGCCsGAQUFBzAChjBodHRwOi8vd3d3Mi5wb3N0c2lnbnVtLmN6L2Ny dC9wc3F1YWxpZmllZGNhMy5jcnQwOwYIKwYBBQUHMAKGL2h0dHA6Ly9wb3N0c2lnbnVtLnR0Yy5j ei9jcnQvcHNxdWFsaWZpZWRjYTMuY3J0MDAGCCsGAQUFBzABhiRodHRwOi8vb2NzcC5wb3N0c2ln bnVtLmN6L09DU1AvUUNBMy8wDgYDVR0PAQH/BAQDAgXgMB8GA1UdIwQYMBaAFPL4zCpXYdorFzNZ 5YIt7AYcik9KMIGxBgNVHR8EgakwgaYwNaAzoDGGL2h0dHA6Ly93d3cucG9zdHNpZ251bS5jei9j cmwvcHNxdWFsaWZpZWRjYTMuY3JsMDagNKAyhjBodHRwOi8vd3d3Mi5wb3N0c2lnbnVtLmN6L2Ny bC9wc3F1YWxpZmllZGNhMy5jcmwwNaAzoDGGL2h0dHA6Ly9wb3N0c2lnbnVtLnR0Yy5jei9jcmwv cHNxdWFsaWZpZWRjYTMuY3JsMB0GA1UdDgQWBBRPckmHWkbCCuiZNkq+twThgZj5CDANBgkqhkiG 9w0BAQsFAAOCAQEAUYsz3k1lWRUnY3RmiLMLOjSVjK4FrGrRgjHulT+oT4X4QQpSK1mxJFJeqvBw U9fo2RTWwO38/PMfU2pgGwwe83L9oCMER8Z2uSzotk59DHzj7WhD2gRL1Lw2NMOmrAlf+JDvdzCv 3rpFOlhLqiI48zw1CtzmnT7pJqCYjUbfbvqIhrMqkcPqAIutuMMKLeb0YetzfsynixpxM5oCJwi3 sucCyxPxsenRd2o90waymPKQla/LjuSSxObeGUaKx+spIJJlomfUb+83hv5XzlSddg0FbgPXGHcL i0sgUvW/Z0uOxIjuxm726+M1Oya2UktAA5t+xS9MVvvY6ktoryzHmw==</ds:X509Certificate>
            </ds:X509Data>
        </ds:KeyInfo>
        <ds:Object Id="_Object_48bc388a-91e7-4d">
            <QualifyingProperties xmlns="http://uri.etsi.org/01903/v1.3.2#" xmlns:ns2="http://www.w3.org/2000/09/xmldsig#" Target="#_SE_72099a3f-52b7-4d">
                <SignedProperties Id="_SignedProperties_981ce866-7ad9-40">
                    <SignedSignatureProperties>
                        <SigningTime>2020-01-14T16:55:17.431+01:00</SigningTime>
                        <SigningCertificate>
                            <Cert>
                                <CertDigest>
                                    <ns2:DigestMethod Algorithm="http://www.w3.org/2001/04/xmlenc#sha256"/>
<ns2:DigestValue>GjWZXdi1hjR1rHX1zUANq3/BnoLbtzs0PZSq2ifr70w=</ns2:DigestValue>
                                </CertDigest>
                                <IssuerSerial>
                                    <ns2:X509IssuerName>cn=postsignum qualified ca 3,o=ÄŤeskĂˇ poĹˇta\, s.p. [iÄŤ 47114983],c=cz</ns2:X509IssuerName>
                                    <ns2:X509SerialNumber>5043793</ns2:X509SerialNumber>
                                </IssuerSerial>
                            </Cert>
                        </SigningCertificate>
                    </SignedSignatureProperties>
                </SignedProperties>
            </QualifyingProperties>
        </ds:Object>
    </ds:Signature>
</ns2:GetProcessingResultResult>
[bookmark: _Ref11225040][bookmark: _Toc41288810]Příprava testovacích dat ve webové aplikaci
[bookmark: _Toc41288811]Vytvoření výskytu výkazu z nepravidelné vykazovací povinnosti
Testovací data lze uživatelsky vytvořit ve webové aplikaci SDAT. Po přihlášení na https://sdatt.cnb.cz/sdat_ext/pages/sdat/common/security/login.zul zvolte v hlavním menu Vykazování - Stav vykazování - přehled. Zobrazí se seznam položek z plánu vykazovací povinnosti vykazující Osoby aktuálně přihlášeného uživatele (tzv. výskyty). V testovacím prostředí nemusí seznam obsahovat žádné položky, proto je nutné zakládat výskyty ručně z nepravidelné vykazovací povinnosti, kterou má na testovacím prostředí přiřazena každá vykazující osoba[footnoteRef:3]. Tato nepravidelná vykazující povinnost umožňuje vytvořit výskyt pro všechny výkazy v systému, které budou v produkčním prostředí zpravidla v pravidelných vykazovacích povinnostech.   [3:  Na produkčním prostředí bude naopak častější scénář automatického zakládání výskytů v čase tak, jak přichází datum odpovídající „stavu ke dni“ výkazů ve vykazovacích povinnostech. ] 
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Výskyty se vytváří pomocí kontextového menu (pravé tlačítko myši v záhlaví seznamu, položka Vytvořit). 
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Vyberte Výkaz a případně změňte Stav ke dni, je-li to pro test žádoucí
[image: ]
Čas předložení je dle zvoleného výkazu dopočítán automaticky dle stavu ke dni a rozsah je pro testovací účely pouze jeden – SDAT. Zvolte Uložit a zobrazí se detail založeného Výskytu
[image: N:\Projekty\SDAT2\AT\0.51.1\2019-06-06_094510.png]
[bookmark: _Toc41288812]Vytvoření vydání výskytu výkazu
Kliknutím na tlačítko Vytvořit na detailu výskytu založíte Vydání, viz obrázek výše.
Alternativně je možné založení i ze seznamu výskytů (viz obrázky níže). Vyberte vhodnou položku ve stavu Plánovaný (sloupec stav) a ve sloupci Editované vydání zvolte buď Vytvořit, nebo Otevřít (pokud jste již v minulosti zahájili editaci). 
[image: ]
Zobrazí se prostředí podobné programu MS Excel s nataženou strukturou datových oblastí příslušného výkazu. Datové oblasti lze přepínat pomocí ovládacích prvků ve spodní části aplikace.
[image: ]
Hodnoty vykazovaných údajů lze vyplnit přímo v této struktuře - každou editaci je nutné potvrdit stisknutím tlačítka Uložit. Alternativně je možné tuto strukturu stáhnout v podobě souboru MS Excel (Ikona Export do Excelu, volba Export pro Import). Editaci je pak možné provést v prostředí programu MS Excel - takto připravený soubor lze nahrát zpět do SDAT pomocí ikony pro Import. 
[bookmark: _Toc41288813]Export hodnot údajů vydání do XML pro SDAT
Uložené hodnoty lze stáhnout pro účely testování webových služeb ve formátu XML (ikona Export do XML). 
[image: ]


[image: ]
Stažený XML soubor je dále nutné komprimovat metodou GZIP a následně vložit jako binární obsah (base64) do XML pro Vstupní zprávu (element Data).
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